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The following icons are used in this user manual:

The information icon precedes important information.

& | Theexample icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon provides a warning against potential mistakes and actions that  could
~ | cause critical error.
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Congratulations on choosing Attix5 Pro Server Edition. Attix5 Pro minimises risk, maximises
productivity and allows businesses to regain control of their most valuable asset - their data.

For technical support, please go toAttix5 Pro SE > About Attix5 Pro  SE, and then use the
contact details provided.

With Attix5 Pro Server Edition ( SE), data stored on servers and databasesan be backed up to a
Storage Platform quickly, securely and automatically.

The following diagram illustrates the scenario:

Files and folders stored on one or more
servers running SE can be backed up
to a Storage Platform. In the event of
data loss or corruption on the server,
you can retrieve data from the Storage
Platform and restore it to the original
or another server in just a few easy
steps.

Storage Platform

A Backup Administrator can manage the entire backup environment (Backup Clients and the
Storage Platform) remotely, using the Attix5 Pro Storage Platform Console. For more
information, please refer to the Attix5 Pro Storage Platform Console User Manual
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1. Getting started

Enabling manual or automatic backups is easy with Attix5 Pro Server Edition :

| ) o

BACK UP
Automaticallyor
ERE)Y

Create a Backup Select files and
gstall SE Acount folders for backup

(See page 14) (See page 33) (See pages 4244)

(See page 7)

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved. n
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Below are the systemrequirements for Attix5 Pro Server Edition .

y Note: For the latest system requirements and compatibility information, please refer to
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pro
software).

System requirements

Operating System

SEis available for the following Macintosh operating systems:
A MAC OS X 10.4 (Tiger)
A MAC OS X 10.5 (Leopard)
A MAC OS X 10.6 (Snow Leopard)

Processor & Memory

A Required: PowerPC G3 with 256MB memory above operating requirements.
A Recommended: PowerPC G5 / Intel Core Duo with 512 MB memory above operating
system requirements.

Recommendation table

Less than 200 GB Pentium 4, Entry level 1GB

200 - 500 GB Pentium 4, 2.0 GHz 1GB

500GB-1TB Dual Xeon, 3 GHz+ 2GB
Disk Space

A Required :50 MB plus space for local cache.

i

Note: Please ensure thatthe drive on which the Backup Client will be installed has
enough free space to storecopies of the selectedfiles.

A Recommended: Amount of free space equal to the Backup Account limit if Binary
Patching is enabled. The space requirement for Delta Blocking is considerably less. For
more information, see Patching in Chapter5, A Backups. 0

=

i

Example : To back up 10 GB of data, at least 10 GB of available free spaceis
required on the drive containing the working folders .

Note: Plug-ins may also require additional working space. For more
information, please refer to the applicable plug -in documentation.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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StorageServer : The local cache can be as large as the total size of all fileimcluded in
the backup selection.

= A 10 GBinclusion may require up to 10 GB free space for the cache.
Database (using Database plug -in) : Space isrequired for the data dump (which
can be as large as the databageand as well the cache(which is the compressed version
of the databasé. Assuming 1:2 compression on a 10GB database you are recommended
to have 15GB (10 GB for the dump and 5 GB for the cache) fee space available.
Temporary working space is also required for subsequent backups; the requirement will
be less than 5GB in the above-mentioned example.

Minimum video requirements: 800 x 600 Resolution, 256 colours
Virtual memory: Double the amount of RAM, with a minimum of 512 MB (Total for
all disk volumes)
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The SEDMG file contains pre-configured information to make installing SE quick and easy.

The options available during the installation process depend on the settings
enabled by the administrator when the DMG file was created. These options range from
advanced install settings to specifying the install location.

v\ | Pre-installation  warnings

A If running antivirus software, p lease ensure that all Attix5 Pro folders are excluded
from being scanned to avoid data corruption.

A Both antivirus software scans and backup processes are resource-intensive. It is
advised not to run a backup and virus scan at the same time as this will
significantly decrease machine performance.

A Please ensure that you run the DMG file suited to the installed operating system
(i.e. 32-bit or 64 -bit). The filename should indicate the target platform. If unsure,
please contact your Backup Administrator.

To install Attix5 Pro SE:

1. Run the DMG file.
2. Run the PKG file.
3. Inthe Attix5 Pro Installer that appears, follow the steps to completion. See below.



Attix5 Pro Installer
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The Attix5 Pro Installer typically consists of four stepsto guide you through the installation in a
simple, step-by-step manner. These steps also make it possible to undo previous operations by

navigating backward.

ly Note: Some of the settings encountered in the installer may have been removed when
the DMG was created. Furthermore, the installer may contain additional step s. Please
read each window carefully before continuing.

Step 1 of 4: Welcome

The Welcome page will outline the task to be performed.

To start the installer :

Click Continue

NeNe

‘w Install Attix5 Pro SE

& Introduction

@ Destination Sele

@ Installatign

® Summanry f

Welcome to the Attix5 Pro SE Installer

o Ir‘stalla:uor&ype}

You will be guided through the steps necessary to

install this software.

Co Back

S

A

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Step 2 of 4: Select an install destination

To select a destination forthe  SE application files and folders:

1. Select the disk on which you wish to install SE
2. Click Continue .

Select a Destination

Select the disk where you want to install the Attix5 Pro SE

© Introduction software.

© Destination Se

‘Macintosh HD
101,83 GB free
119,69 GB total

| Installing this software requires 17,3 MB of space.

Y (L
25

( GoBack ) ( Continue )

Wz

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



Step 3 of 4: Install

To begin the SE instal
Click Install

v

Location button.

lation

ATTIX®

Tip: Should you wish to change the install location, you can use the Change Install

i) | Note: At this point, you may be prompted to provide a password to allow the installer
to make the required changes to the operating system. Supply your Mac username and
password in the boxes provided, and then click OK..

ann '« Install Attix5 Pro SE
Standard Install on “Macintosh HD"
& Introduction
© Destination Sel This will take 17,3 MB of space on your computer.
e InstallatioJTy Click Install to perform a standard installation of
® Installatian this software on the disk “Macintosh HD".
® Summary ',.‘"
i -|-'-'|""'|I""-"
- 1
»
| Ii Change Install Location... :'
( Go Back ;‘I ( Install ;‘I
P

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Step 4 of 4: Close the installer

To close the installer
Click Close.

fNno « Install Attix5 Pro SE

The installation was completed successfully.

O Introduction

© Destination Sel

(5] InstallatloiTyg

3

(G] Installauon u

© Summary The installation was successful.

W un\nn\uu\‘
.\II\\IIHHHI‘!HI 4 \‘
!
0 1

The software was installed.

@

Go Back ( Close )
4

After clicking Close , Attix5 Pro SE will be installed on the machine.
Upon opening the SE Client for the first time, the Backup Account Setup Wizard will

launch, enabling you to create a Backup Account. Follow the wizard steps as describedin
Chapter 3, fiAccount setup.o

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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To be able to backup or restore data using the Backup Client, a Backup Account is required.

The Account Setup Wizard will launch when the Backup Client is opened for the first time (for
more information, see Opening the Backup Clienti n Chapter WdsefGFrapbrtateoo).

i) To run the Account Setup Wizard at any other time : On the Tools menu, click
Account Setup Wizard . In the warning box that appears, click the Run Account
Setup Wizard button and follow the instructions below from Step 2 onwards .

The Account Setup Wizard typically consists of eight stepsto guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previous operations
by navigating backward.

i) Some of the settings encountered in the wizard may have been removed when the
DMG was created. Furthermore, the wizard may contain additional step s. Please read
eachwindow carefully before continuing.
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This step displays when the wizard is run directly after the SE Client installation.

If accessing the wizard at a later stage ( via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform connection settings:

1. In the Storage Platform address box, type the IP address or DNS name of the
Storage Platform where the Backup Account resides

2. In the Group name field, specify
which Backup Group the Account
belongs to.

3. In the Group create key field, specify the preconfigured Group create key for the
applicable Group. If you do not have access to this key, please contact your Storage
Platform administrator.

i) This key is case sensitive.
4. Once all the correct settings have been entered, tick Next .
ano Account Setup Wizard
Enter the Storage Platform connection settings. ] @
Please contact your backup administrator if you do not have the reguired information. Lh_
Storage Platform Settings
Storage Platform address: | 192.168.20.215
Group name: A-SP OWNER\RESELLER A\BACKUP ACCOUNTS
Group create key: en
ATTIX®Pro
( Help \: = Back | Cancel \:/
.




ATTIX®

This wizard step is typically the first to be displayed if you access the wizard via

the Tools menu.

You can selectl want to connect to an existing Backup Account to:
Connect to an Account that has been opened for use by this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.

To create a new Backup Account:

1. Selectl want to create anew  Backup Account
2. Click Next .

To connect to an existing account:

1. Selectl want to connect to an existing Backup Account

/0 | Warning:  Different servers cannot back up to the same Backup Account. A
separate Backup Account needs to becreated for each server.

2. Click Next to continue.

8.0 Account Setup Wizard i
Specify the account type. ] @
Choose between a new or existing Backup Account. You cannot connect to the same Backup Account from different machines. [L

Account Type

Please select one of the following:
@ Iwant to create a new Backup Account.

O I want to connect to an existing Backup Account

ATTIX’Pro

( Help ] < Back [~ Mext> ) [ Cancel )
~ | S

—

A
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Depending on the option you selected in the previous step, you will either be prompted to
specify new Account details or to supply the already configured details ofthe existing Account.

To specify the new  Account details:

1. Inthe Backup Account name box, type an Account namethat consists of a minimum
of 4 characters.

2. In the Account password box, type a password that consists of a minimum of 4
characters.

3. In the Confirm password box, repeat the Account password entered in the Account
password box above.

4. In the Encryption key  box, type an encryption key that consists of a minimum of 8
characters.

L Warning : Disaster recovery is not possible without the encryption key. Please
ensure that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT
STORED ON THE STORAGE PLATFORM AND CANNOT BE RECOVERED OF
RESET IF LOST.

5. Click Next .
aNeO Account Setup Wizard

Enter the existing account details.

Supply the Backup Account details that you want to reconnect to. L ! @

Account Details

Backup Account name: | BACKUP ACCOUNT 01

Account password:  esssss

Encryptionkey: [ qeennes

ATTIX’Pro

:/ Help \: ;/ < Back \: ( Next > '\ :/ Cancel \:

A
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When connecting to an existing Account:

1. Inthe Backup Account name box, type the Account name.
2. Inthe Account password box, type the Account password.
3. Inthe Encryption key  box, type the encryption key chosen when the Backup Account

was created.
8.0 Account Setup Wizard
Enter the new account details. r @
Choose and enter your preferred account name, password and encryption key. I ‘ | -

Account Details

Backup Account name: | BACKUP ACCOUNT 01

Account password: ssssee
Minimum 4 characters
Confirm password: ssssee

Please choose an encryption key of B characters or more that will be used to encrypt your backups on the server. Note: If you lose
this key you will not be able to restore your data, so write it down and store it somewhere safe.

Encryption key: sssssnne

Minimum 8 characters

Confirm key: sssssnne

ATTIX’Pro

( Help ) ( <Back ) (Nent>) (" cancel )

A

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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To specify the connection settings:

1. In the Connection Settings area, selectl use broadband or another permanent
network connection
2. If a proxy server is to be used:
2.1. Click the Configure Proxy  button.
2.2. Inthe Proxy Setup dialog box that appears, select a proxy type.
2.3. If Use SOCKSvV5 Proxy or Use HTTP Proxy is selected, fill in the Proxy
Host and Proxy Port boxes.
2.4. If login details are required, select the Proxy server requires authentication
check box and type the username and password in theboxes provided.
2.5. Click OK to close theProxy Setup dialog box.
3. Click Next to move to the next step in the wizard.

ano Account Setup Wizard
What kind of connection do you have? r @
Select the type of connection that you use to connect to the Internet. [L

Connection Settings
I use a modem/dialup connection.
@ I use broadband or another permanent network connection

[ , Y
| Configure Proxy |

ATTIX’Pro

!/ Help ) :/cBack ] (Nent>) !/Caru:el )
/4
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Attix5 Pro can run backups on included files and folders either upon request (manually) or
automatically. This step enables you to set up abackup schedule.

It is advised to back up at night when the server is running and the Backup Client is

not in use. The server must be switched on at the time (s) specified for scheduled backups,
but the Mac user doesnot needto be logged in.

To configur e the Backup Client to run only manual backups:

1.
2.

)

Clear the D aily automatic backups check box
Click Next to move to the next step in the wizard.
Warning:  This option is not recommended. If an automated backup scheduleis not

created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

To schedule daily automatic backups

1. Select theDaily automatic backups check box

2. Inthe Back up every day at  box, specify a backup time.

3. Click Next to move to the next step in the wizard or schedule additional advanced
backups as described below.

ano Account Setup Wizard

Do you want to

hed dhb ?
Specify the daily and hourly backup schedule. You are strongly rec to enable ic backups. L | @

Automatic Backups

E Daily automatic backups

Back up every day at: ﬂ 19h 00 @
|| Advanced Schedule
Back up at the following times
Week Day Additional Schedule

Backup time:

&

ATTIX’Pro

Help \: [ < Back \: (Newt>) | Cancel \:
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To schedule advanced backups:

1. Selectthe Advanced Schedule check box.

In the Week Dayarea, selecta day on which a backup should be initiated.

Specify thetime in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule  box.
Repeat the steps above until you have added all desired schedules to theAdditional
Schedule box.

6. Click Next to move to the next step in the wizard.

a b N

- YeYe) - - - : Account Setup Wizard

Do you want to schedul t ted back ? r @
Specify the daily and hourly backup schedule. You are strongly rec to enable ic backups. ‘ |

Automatic Backups

E Daily automatic backups

Back up every day at: ﬂ 19 h 00 @
[ Advanced Schedule
Back up at the following times
Week Day Additional Schedule
[Monday | Backup time: Sunday@12h00

Tuesday = 12n00 @ Saturday@12h00
Wednesday

Thursday

Friday
Saturday Delete

[— <+

ATTIX’Pro

( Help ) ( <Back ) (Nent>) (" cancel )

)
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Step 6 of 8: Specify working folder locations

Under normal circumstances, the default Temp , Cache, Logs and Database folder locations
can be accepted andyou can click Next without making any modifications. If, however, the
drive on which the Backup Client is installed has limited space available, you can move the
folders and selection databaseto another location.

/v, | Warning:  Please ensure that these folders are located on a drive with sufficient free
space.

To change the temp , cache, logs and/or database folder locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a
different location for that folder.

2. Repeat step 1 above until all folder locations are correctlyspecified.

3. Click Next to continue with the installation process.

/1, | Warning:  The Cache and Temp folders must reside on the same drive/volume.

8.0 Account Setup Wizard

Do you want to modify the default working folders?
You can move the Cache, Log, Temporary folders and the Selection Database to another location if there is limited space available on the .
drive where the Backup Client is installed. ‘ |
Working Folders
Note: Always keep these folders on the same drivefvolume.

Temp: [Applications/Attix5 Pro.app/Contents/Resources/toBackup '/ Browse... \
Cache: [Applications/Attix5 Pro.app/Contents/Resources/cache '/ Browse... \
Logs: [Applications/Attix5 Pro.app/Contents/Resources/logs '/ Browse... \
Database: [Applications/Attix5 Pro.app/Contents/Resources '/ Browse... \

/

ATTIX’Pro

( Help ) ( <Back ) (NE:¢>) (" cancel )

A
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Attix5 Pro SE V6.0 installs with the Email N otification plug -in by default. In this step, you can
configure this plug-in or accept its default configuration and proceed to the next step in the
wizard.

To configure a plug -in:
1. Inthe Configurable plug-ins list, click the plug -in name.
2. Click the Config ure button.
3. Configure the settings as required. (For more information on configuration options, see
Chapter -i9ns @i.P)l ug
4. Click OK to close the dialog box and return to the wizard.
5. Click Next to continue to the next step in the wizard.

. Yere) - - - : Account Setup Wizard

Plug-in Configuration

The following plug-ins can be configured now, or you can configure them later via the Tools 1 @
| Plug-ins menu option. [L

Configurable Plug-ins

Email Notification v2.10

ATTIX’Pro

!/ Help ) :/cBack ] (Nent>) !/Caru:el )
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In the final step of the Account Setup Wizard, a Summary screen displays a list of the configured
settings.

To confirm the Setup information:

1. Read and verify that the information is correct, and then click Next .
2. The Backup Client will connect to the Storage Platform and configure the Backup

Account. A message will be displayed to confirm that the Account was set up
successfully.

3. Click OK to close the message box.

Now that a Backup Account has been configured onthe Storage Platform, you can select the files
and folders you wish to back up.

aNeO Account Setup Wizard
Confirm your account settings. @
If the settings below are correct then click Mext, otherwise click Back to change your settings. E !
Summary

You have entered the following information:

Attix5 Pro Username: BACKUP ACCOUNT 01
Connection method: Local Area Network
Automatic backups:

Backup daily at: 19h00

ATTIX Pro

:/ Help \: :/ < Back \: ( Next = ) :/ Cancel \:
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups

To open the SE Client interface:
Click the Attix5 Pro icon in the Dock.

i) The first time you open the Backup Client, the Account SetupWizard launches
automatically . For more information on creating a Backup Account,seeChapt er 3,
setup. o



The Client interface explained
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You can manage and monitor backups using the Backup Client application window.

Application window

The Backup Client application window contains the following areas:

® Attix5 ProSE  File Tools Help <— [E] w0 O § = A
— Menu bar
o At Pro SE¥6.0.0
— - (&4 Product He
3 Qe @@ S [ ook
—_— H
Backup Sie Restore Find || Options | Automate | Help n"Ixspm
E— i ] o
@l My Computer Filename /3 size Date
vol L fseventsd 0104012 Quickstart __— Product Help
» [ foeventsd L= Spotlight-v100 2009-01-1 Sten-by-step quide L —
- e |~ Trashes 2009-09-0.. /
» |~ Spotlight-v100 [ 2009-05-1. Backups: How to...
b | Trashes |~ Applications 2010-01-2.. Select data Status bar
7 ol = bin 2009-09-0.. Use selection filters /
- o P Export a selection report
P L= Applications L cores 2005-06-2 Back up manually
L= bin l: dev 2010-01-2.. Schedule automatic backups
~ L= Developer 2009-09-1..
= cores L= hannes 2010-01-1
L= L= home 2010-01-2.
» | Developer =’ hudson 2010-01-2. -
L= hannes |~ Lbrary 2010-01-1,
= home = 2010-01-2.
b &= hudson L= Network Account and security
~ o = private Connections
¥ L= Library L= shin Backup schedule
| net = s Backup throttle
L= Network L= System Display.
- - Disk usage.
» | private £ Users Performance and limits
£ sin B Global filters
- L= Volumes Patching
> s ©  .DS_Store 15 KB Mandatory patching
b L System O file 0KB Logging
» | Users O hatf 128 KB . Advanced options
P usr S 1823548 2 Additional information
» | volumes ~ Resuming backups
MNotifications
Server Edition auto-updates
A Concurrent backup processing.
Agding network volumes.
Ready

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Menu bar and toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most
commonly used menu bar functions are also available on the toolbar and shortcut (Control-

click) menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables belowv describe the
Attix5 Pro options available.

Attix5 Pro SE menu

About Attix5 Pro  SE

Preferences

Hide Attix5 Pro  SE

Quit Attix5 Pro  SE

File menu

Access the product information and support contact details.

Opens the Options and Settings  dialog box that enables you to modify a
range of Client settings. For more
Settings. o

Hides the Attix5 Pro SE application window.

i)l Note: This will not stop the Attix5 Pro service from running
scheduled backups.

Closes the Attix5 Pro SE application.

Backup Now

Restore

Calculate Size

Initiate a Backup immediately.

Switch to the Restore view in the Client.

\j Tip: For faster access to the Restore view, click the Restore tab
instead of using the File menu.

Determine the total size of the dataincluded in the backup selection. For more
information, see Determining the backup selection size in Chapter 5,
AfBackups. o

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



File menu continued...
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Find Files in Backups

Export Selection

Access theFind Files in Backups  dialog box. This box enables you to
search for particular files in your backups. For more information, see
Finding files in backups in Chapt:

Export a list of all backup inclusions and exclusions to an html file for
future reference. For more information, see Exporting a selection report

in Chapter 5, fiBackups. o

Tools menu

Additional Backup Sets
> Add

Additional Backup Sets

> Manage

Automati ¢ Backups

Account Setup Wizard

Remote Management

Create additional backup sets. This enablesyou to have separate backup
selections that you can recoveras separate sets of files.For more
information, see Multiple Backup Sets in Chapter 8, Ogtions and
Settings. 0

Access the Backup Schedulg@agein the Options and Settings  dialog
box. Using the settings in this dialog box, you can manage the
schedule(s) of your backup sets. For more information, seeMultiple
Backup Setsin Chapter 8, Opiions and Settings. 0

Access the Backup Schedule settings in théptions and Settings

dialog box. Configure the settings in the Automatic Backups area to set

up one or more automatic backups. For more information, see

Scheduling automatic backupsi n Chapter 5, ABack:!

Launch the Account Setup Wizard, which enables you to change the
Backup Account settings. For more information, see Account Setup

N

WizardinChapter 3, fAAccount setup. o

Access theRemote Management Settings  dialog box. Using the
settings available, you can enableRemote Management of the Client via
the SP Console. For more information, seeRemote Management in
Chapter 8, AOptions and Settings..

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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7ools menu continued...

Health Check

Snapshot > Export Backup
Snapshot

Snapshot > Import Restore
Snapshot

Plug -ins > Email

Notification

Access theHealth Check dialog box. Performing a Health Check
enables you tohighlight possible issues. For more information, see
HealthChecki n Chapter 8, AOptions anc

Accessthe Export Backup Snapshot dialog box, which enables

you to configure the next backup to bea Snapshot backupto a

specific location. For more information, see Backup Snapshotsin
Chapter 8, AOptions and Settings

Accessthe Import Backup Snapshot dialog box, which enables
you to configure Restore Snapshot settings For more information,
seeRestore Snapshotsi n Chapter 8, AOptionse

Access theEmail Noatification settings dialog box, which you can use
to enable/disable email notification and configure its settings. For
more information, see Email Notification plug -in in Chapter 9,
APl-iurgs . O

Icon Legend

Product Help

Access a list of the cons used in the Attix5 Pro Client and the statuses
they indicate.

Access the Product Help.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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[ & Backup Selection = .l Restore =) Logs |

g My Computer Filemame /% Size Date
£ lL Ffseventsd 2010-01-2...
|~ fseventsd ||__: Spotlight-v100 2009-01-1...
- .Trashes 2005-09-0...

There are three tabs availablein the Backup Client:
Backup Selection: This tab displays the files and folders on the computer, enabling
you to select the items to be backed up For more information , see Selecting data to
backupi n Chapter 5, fABackups. o
Restore: Use this tab to browse previous backups and restore files and folders.
Logs: Use this tab to view detailed information on each backup and restore.

When the Backup Selection and Restore tabs are selected you can click any of
the column headings in the right -hand pane to sort the contents accordingly .
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Product Help

@ You can acess theBackup Client Help by clicking Product Help  on the Help menu.

: Alternatively, click the Help button on the toolbar.
Help

As you navigate the Client, the Help pane will display information relevant to the selectedtab.

4 Product Help

You can tell the Backup Client which files
andfor folders to back up & nd which to

ignore by clicking the ﬂ Backup
Selection tab and then including or
excluding the items as described below.

Tip: Once a file or folder is included in
the backup selection, any modifications
to it will be backed up automatically.

How to...

Include an individual file

Include an entire folder

Exclude a file or subfolder
Calculate the backup selection size

To include an individual file:

In the Backup Selection tree, navigate to
the falder or directory containing the
file. In the right-hand pane, click the file
iCon [‘T‘} or point to the file name and
Control-click, and then click Include. An
included file is displayed with a green
icon: &,

To deselect a file, you can either click
the icon again or point to the file name |
and Cantral-click, and then click

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Status bar

This area displays the date and time of the last backup performed by the system.

Ready Last backup:Jan 23, 2010 4:10:58 PM
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After installing Attix5 Pro Server Edition ( SE) and creating a Backup Account,you can tell the

Backup Client which files and/or folders to back up and which to ignore by creating a backup

selection ( see A Sel dgockadkom @ 0 d & eYow ean then start a backup manually or

schedule automatic backups ( see HfAPer f or miakmkuao mandaliSbhedul ing a
backupsodo bel ow) .

i) Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Selectdata to back up

Usefilter s to specify files and/or folders to be excluded from the backup selection.
Determine the backup selection size

Start backups (automatically and manually)

Cancel a backup

Resume a failedor cancelled backup

You can make your first backup selection or modify a backup selection at any time using the
Backup Selection tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file or
folder.

3. Include or exclude files and/or folders, as described below.

Once a file or folder is included in the backup selection, any modifications to it will
be backed up automatically. For more information, see Patching i n CI
and settings. o0

1, | Warning:  If you have limited space on the drive running the Backup Client, it is
recommended that you move the Cache , Logs and Temporary folders as well as the
selection database to another location. For more information, see Disk Usagein
Chapter 8, AOptions and Settings. o
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To include an individual file:

In the Backup Selection tree, navigate to the folder or directory containing the file. In the right -
hand pane, click the file icon (7)) or point to the file name and Control -click, and then
click Include . An included file is displayed with a green icon: ©.

To deselect a file, you can either click the icon again ormpoint to the file nam e and Control-
click, and then click Deselect . A folder containing some included files is displayed with a green
tinted icon: =,

To include an entire folder:

Point to the folder icon ( L-) and Control-click, and then click Include Folder . Alternatively,
you can select the folder in the Backup Selection tree, and then clickinclude Folder on
the Selection menu. Included folders are displayed with a green icon: L=,

i All files in the included folder and its subfolders will be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder:

Point to the folder icon, Control-click, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included bu t you wish to exclude a particular file or subfolder, point to the

file or folder icon and Control -click, and then click Exclude or Exclude Folder . Excluded
items are displayed with red icons: & or £ Folders that have been included but have some
files or subfolders excluded are green with a red tint: .

You can create different backup selections for different backup sets. For more
information,see Mul t i pl e Backup Sets in Chapter
You can usefilters to automate file selection based on file types.

Once you have selected all files to be included and excluded, it may be useful to
check the size of your backup selection before initiating your first backup. For
more information, see Using filters later in this chapter.

i) Some directories (and their contents) are forcefully excluded from the backup
- | selection. On Mac machines, these are the/dev and /proc directories.
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You can use filters to automate file inclusions or exclusions within a folder, based on file types.

x A *. pdf filter will include or exclude all PDF files within a folder, as well as
any new PDF files that are added to that folder later.

To apply a predefined filter to a specific folder:

1. Inthe Backup Selection tree, point to the folder icon and Control -click.

2. Point to Filters .

3. Point to one of the available filters in the list (e.g. MS Office documents ).
4. Click Include or Exclude .

To modify an existing filter:
1. Inthe Backup Selection tree, point to the folder icon and Control-click, point to Filters
and then click Edit filters
2. Select one of the filters andthen modify its properties in the Edit filter  box.
3. Click OK.

To add a new filter from within the Edit filters  dialog box, click the New button,
supply a name that describes the filter, enter the file type(s), and then click OK.

To add a new filter via the Backup Selection tree:
1. Pointto the folder icon, Control-click, and then click New filter
2. Inthe Filter name box, type a name to be used in the Filters menu.
3. Inthe Filter box, specify the file extensionsto which the filter will apply.
4. Click OK.

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

1. Pointto the folder icon and Control-click.

2. Pointto Filters .

3. Point to the name of the filter you wish to remove.

4. Clear the check mark next to the selection (nclude or Exclude ).

To identify files and  folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with
icons containing blue check marks: & and v
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Some inclusions and exclusions are enforced atadministration level on the Storage Platform.
This i s c¢al | Fodmoiepnfoonfitiod, see gPoofiing i n Chapter 8, AOption
Settings. 0

Files and folders affected by profiling display with the following icons :

File inclusion

g Filtered file inclusion
File exclusion
Folder inclusion

¥ Filtered folder inclusion

(x] Folder exclusion

Profiled selections cannot be modified from within the Backup Client and can o nly be
changed on the Storage Platform. For more information, please refer to the Attix5 Pro
Storage Platform Console User Manual
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Icon legend

On the Backup Selection tab, eac
colour oftheiconi ndi cat es

h file and folder is displayed with an associated icon The

the file or folderds bachkup

backup selections, sSeel efict i ng d adardier ihtbis dhepterl u p O

E ‘s Backup Selection | il Restore = Logs "

ﬂ My Computer
v .!";_lﬂ F
3 ﬁ Trashes G
L ol =

The following icon legend lists the

Filename /% Size Date
.Trashes 2010-01-2...
ol 2009-01-1...
Applications 2009-09-0....
bin 2009-05-1...

Attix5 Pro icons and the statuses they indicate. You can

access this legend byclicking Icon Legend on the Help menu.

Icon legend

| o File (not selected)

[ Selected by user

g Selected by user filter
[= Excluded by user

[ %] Excluded by

administrator

E Included by profiling
g Included by profiling
filter

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved

The file exists in the folder or directory but is not included in the
backup selection (neither included nor excluded).

The Backup Client user hasincluded the file in the backup
selection.

The Backup Client user has applied a filter to the parent folder or
directory. That filter has included the file in the backup selection.

The Backup Client user hasexcluded the file from being backed
up to the Storage Platform.

The Backup or Storage Platform Administrator has excluded this
file or its file type. Files displaying this icon will not be backed up
to the Storage Platform.

The Backup or Storage Platform Administrator has included this
file or file type. Files displaying this icon will be backed up to the
Storage Platform and cannot be deselected from within the
Backup Client.

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon cannot
be deselectedor excluded from within the Backup Client.

s el

ec



Excluded by profiling

Folder (not selected)

Some files selected by
user

All files selected by user

All files selected by user,

some excluded

All files excluded by the

user

Filter applied by user

Filter applied by user,
some excluded

All files included by
profiling

Filter applied by
profiling

Filter applied by
profiling , all items
excluded

Filter applied by
profiling, some items

included by user

ATTIX®

The Backup or Storage Platform Administrator has excluded this
file or its file type. Files displaying this icon will not be backed up
to the Storage Platform and cannot beincluded in the backup
selection from within the Backup Client.

The folder exists in the directory but it is not included in the
backup selection.

The Backup Client user hasincluded some filesin the backup
selection.

The Backup Client user hasincluded all files in the backup
selection.

The folder contains no unselected files. Each file is either
included or excluded.

The Backup Client user hasexcluded all files in the folder from
being backed up to the Storage Platform.

The Backup Client user has applied a filter to the folder. The
filter has included one or more files within the folder.

The Backup Client user has applied a filter to the folder that has
included and excluded files within it.

The Backup Administrator has included all the files contained in
the folder. All files will be backed up to the Storage Platform.
Theseinclusions cannot be changed by the Backup Client user.

The Backup Administrator has applied a filter to the folder. This
filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to the folder ,
resulting in the folder being excluded from the backup selection.
This filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to this folder using
profiling and some items have been manually included by the
Backup Client

user (see

chapter).

nSel ec
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e}

(GUI) &

Filter applied by
profiling, some items
included and some
items excluded by
user.

Filter applied by
profiling but items
excluded by user.

Folder excluded by
Global Filter.

All files excluded by
profiling

Plug-in node (not
selected)

Some items selected
by user

All items selected by
user

All items selected by

user, some excluded

All items excluded by
user

Filter applied by user

Filter applied by user,
some excluded

For more information, see Profiled selections i n
and-inPih Qlgapt er

The Backup Administrator has applied a filter to this folder using
profiling. Some items have beenexcluded and others included by
t he Client
this chapter).

Backup user (see AS

Items in the folder have beenincluded using filters (seefUsing

filterso6 earl i er in this chapter.)

The folder has beenexcluded using Global Filters. For more

information, see Global Fitersi n Chapter 8, i O

settings. o

The Backup Administrator has excludedall files in the folder.
Theseexcluded files cannot be included by a Backup Client user.

The plug-in exists but is not selected for backup to the Storage
Platform.

The Backup Client user has selected some of the items in the
plug-in for backup to the Storage Platform.

The Backup Client user has selectedall items in the plug -in for
backup to the Storage Platform.

The Backup Client user hasincluded and excluded items in the
plug-in.

The Backup Client user hasexcluded all items in the plug-in
from being backed up to the Storage Platform.

The Backup Client user has applied a filter to the plug-in;
specifying that certain file types must be included for backup to
the Storage Platform.

The Backup Client user has applied a filter to the plug-in;
specifying that certain file types be included for backup to the
Storage Platform but some items have beenexcluded either

through the use of an exclusion filter or by manual exclusion.

Chapter 4,

-9ns APl ug

AGrap
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It is useful to determine the backup selection size beforestarting the backup process to avoid
Over Limit errors.
The Backup Client compares your backup selection size with the Backup Account

limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceeds the Account limit, the backup process will stop and anOver

Limit error message will be displayed.

To calculate the backup selection size:

A. On the File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar:

=) r@@ °eee

Restore Find :| Options | Automate Halo

Bachup

The Backup Selection  Size dialog box that appears displays total size of your backup
selection (i.e. all files included for backup).

Backup set index prepared in < 1s
Files and directories: 0 Total size: 0 bytes

/v, | Warning:  If your backup selection size exceeds your Account limit, you need to remove
some items from the selection or ask your Backup Administrator to upgrade your

Account limit.

To remove a file from the backup selection:
A. In the Size dialog box, pointto f i | e & © and €amtnol-click. The icon will turn red to

indicate that it is excluded: &.

To exclude multiple files at once, click a file name in the list, hold down the
Shift key and drag the mouse pointer to highlight the files. Place the mouse
pointer over the selection, Control -click, and then click Exclude .
B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are
currently selected for backup. For more information, see Selecting data to back up in

Chapter 5, fABackups. o
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After creating a backup selection, you can export a list of all backup inclusions and exclusions to
an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How each item was selectel (user-selected, filters, profiling or mandatory patching)

Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. Onthe File menu, click Export Selection
2. Inthe Save As dialog box, select the location in which to save the file, type a file name

in the File name box, and then click Export .

The file will be saved to the specified location and can be viewed in any Internet browser.
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It is recommended that you run a backup manually after creating your backup selection
to ensure immediate data transmission to the Storage Platform . Thereafter, automatic backups
will ensure hassle-free continuous backups. For more informat i o n, s dirg auoBati €
b a ¢ k Uapesimthis chapter .

To starta backup manually :

1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

Backup

The Backup dialog box appears and displays the progress of the backup:

BN O Backup

Backup successfully processed on server
| |0 minutes 1 seconds total transfer time

Updating local cache

Cleaning up cache

Dwoing monthly cache cleanup

Cleaning up temporary files

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue
will display in the Backup dialog box, enabling you to cancel the current backup in
favour of the next, should you wish to do so. For more information, see Multiple Backup
Setsin Chapter 8, Opitions and Settings. 0

2. To close the Backup Qient after the backup process has started, click theHide button.
This will not cancel the backup process and the Backup Client can be r®pened at any
time to view the progress of the backup.

You can monitor the backup progress at any time by pointing to the system tray icon,
Control -clicking, and then clicking Monitor Progress
To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 8: Schedule Backup Processin Chapter 3 , iAccount yoSeah enpblepnd b u t
schedule them at any point in time using the Options and  Settings dialog box.

To schedule daily automatic backups

1. On the Attix5 Pro  menu, click Preferences . Alternatively, click the Options button
on the toolbar.

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the
Backup Set drop-down box. (For more information on backup sets, see Multiple
Backup Setsin Chapter 8, Opgtions and Settings. )0

4. Select the Daily Automatic Backups check box and then specify a backup time in
the Back up every day at  box.
5. Click OK.

To schedule advanced backups:

1. Onthe Attix5 Pro menu, click Preferences .

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the carect set is selected in the Backup
Set drop-down box. (For more information on backup sets, see Multiple Backup Sets in
Chapter 8, AOptions and Settings. 0)

Select theAdvanced Schedule  check box.

In the Week Day box, select a day on which a backup shouldoe initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat steps5 to 7 above until you have added all desired schedules to theAdditional
Schedule box.

© N o oA

You are advised to back up at night when the server running the Backup Client is
not in use. It must be switched on at the scheduled backuptime(s), but the Mac user
does not need to be logged in.

Configuring automatic backups ensures that all selected data is backed up
automatically, without the need for any user interaction. This is a safer alternative

to relying on manual backups.
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Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup

n_NeNe Backup

Backup successfully processed on server
0 minutes 1 seconds total transfer time
Updating local cache

Cleaning up cache

Doing monthly cache cleanup

Cleaning up temporary files

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue will
display in the Backup dialog box, enabling you to cancelthe current backup in favour of the
next, should you wish to do so. For more informatio n, seeMultiple Backup Sets in Chapter 8,
fiOptions and Settings. o

Tips:
To close the Backup Client after the backup process has started, click the Hide button.
This will not cancel the backup process andyou can re-open the Backup Client at any
time to view the progress of the backup.
You can monitor the backup progress at any time by pointing to the system tray icon,
Control -clicking, and then clicking Monitor Progress
To view backup logs, dick the Logs tab. Backup log dates are displayed in blue.

i & Backup Selection <l Restore ~ | Logs ]

pEmEL Rl E i I | Message: 18:43:20 5at, 23 January 2010 6:43:19 PM - V6.0.0-700 : Ma
23 Jan 2010, 18:33:28 |Message: 1B:43:20 05: Mac 05 X, 10.6, i386

Message: 1B:43:20 Preparing selection database

Message: 18:43:20 Initial file set prepared

Backups will be stored on the Storage Platform and accessible via theRestore tab. For more
information on restoring data, see Chapter 6, fARest
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Cancelling a backup

Once a backup is in progress,you can cancel the process via the Backup progress window or
using the system tray icon.

To cancel a backup:

In the Backup progress window, click the Cancel button.

M
~ Compressingand patching

Connecting to service

Starting backup

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.245:443
Server name: Storage Platform, Attixs Dev QA,
Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.245:443
Server name: Storage Platform, Attixs Dev QA,

Building selection list

Total selection: 302 bytes in 2 files and folders
Checking for differences

Patching backupset.xml

Ceancet )| (_tice )

The backup will be cancelled.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successfuland a
manual backup is initiated, the Backup Client will display the prompt: Do yo u want to
resume the failed backup ... ?0with a 30 second countdown. Click Yes to instruct the Backup
Client to try to continue from where the process fail ed during the previous backup. Click No to
initiate a new backup or Cancel to return to the Backup Client application window .

A new backup will be initiated automatically after the countdown has elapsed.
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On the Restore tab, you can browse a tree structure representation of all successful backups
and their files and folders.

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

On the Restore tab, the Restore tree gives you access tdacked up files via two main nodes:
Last Backup and Previous Backups

i & Backup Selection 2l Restore | =| Logs '

I W Backups | Filena... %f| Size Date File type

k. Last Backup (27 Jan 2010, 14:5:

s
k. Applications

k. Previous Backups

The Last Backup node contains the file/folder structure of the last successful backup and
displays the date and time it occurred in parenthesesii (. ) 0

i) Restores done from the Last Backup node are typically faster than those done
from the Previous Backups node as the Backup Client may be able to retrieve the data
from the cache instead the Storage Platform.

When you expand the Previous Backups node, the Backup Client retrieves the list of previous
backups from the Storage Platform and displays them in the tree.

To select and restore data  from the

1. Click the Restore tab.

2. Expand the Last Backup node to view the files/folders.

3. Include a single file by clicking the T icon next to the file or by pointing to the file
name, Control-clicking, and then clicking Include . Eachincluded file is displayed with
a green icon: &,
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4. Include an entire folder by pointing to the folder, Control-clicking, and then clicking
Include folder . Eachincluded folder is displayed with a green folder icon: L=
5. If an entire folder is included but you wish to exclude a particular file or subfolder, point
to the file or folder icon, Control-click, and then click Exclude or Exclude Folder
Excluded items are displayed with red icons: & or £¥ . Included folders that have some
files or subfolders excluded are green with a red tint: .
6. Once all the files and folders to be restored are selectedstart the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options available, seefiRestoringdatad | at er i n this cha

To select and restore data from

1. Click the Restore tab.

2. Expand the Previous Backups node to connect to the Storage Platform and retrieve a
list of all previous backup dates.

3. Expand the relevant backup node, and then click the folder/directory containing the
data.

4. Include a single file by clicking the ' icon next to the file or by pointing to the file
name, Control-clicking, and then clicking Include . Each included file is displayed with
a green icon:

5. Include an entire folder by pointing to the folder, Control-clicking, and then clicking
Include folder . Each included folder is displayed with a green folder icon: L.

6. If an entire folder is included but you wish to exclude a particular file or subfolder, point
to the file or folder icon and Control-click, and then click Exclude or Exclude Folder
Excluded items are displayed with red icons: ® or £ Included folders that have some
files or subfolders excluded are green with a red tint: =3

7. Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
infformation on the restor e Regtoringdatdbetow.ai | abl e, see #
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Restoring data

After you have selected the files and folders to restore, you canstart the restore process as
described below.

To start the restore process:

1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
2396 @ 0@

The Restore dialog box will prompt you for a restore location:

Save files in:

O Original location

: : ( 3
{®) Folder: | /Users/attix5/Restore ( Browse )

2. SelectOriginal location  to restore the files to the same location that they were backed
up from or selectFolder and then browse to a new location.

/2 | warning:  If Original location is selected the restored files will overwrite
any existing files with the same name in that location. A warning will, however,
be displayed before the Backup Client overwrites any files.

In the Options area, specify the restore options.

Options

E Recreate directory structure

E Restore empty folders

[ ] Overwrite files

E Use compression (faster over the Internet)
E Restore file and folder permissions

z Restore directly to target location (faster, but resume on file level not possible)

For more information on restore options, see the

3. Click OK.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Restore options

Recreate directory

structure

Restore empty folders

Overwrite files

Use compression

Restore file and folder

permissions

By default, the folder structure is recreated in the Restore folder. To
specify that all files be restored to one location, clear the Recreate
folder structure  check box

i) | Note: If restoring files from different folders with the
same file names, you need to recreate thedirectory
structure to prevent overwriting the files.

To restore all empty folders within the directory structure, select the
Restore empty folders  check box Clear the check box to restore
only those folders containing backed up files.

1/ Note: This option is only available when Recreate
directory structure is selected.

Selectthis option to prevent the Backup Client displaying a prompt
before overwriting existing file s.

o" Y
i AN
H

/¥ | Warning:  If this check box is selected, files with matching

filenames in matching directories will be overwritten
without warning.

Select theUse compression  check boxto enable the Storage
Platform to compress files beforetransmitting them to the Backup
Client.

\j Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will
reduce the size of the files, making the transfer
process faster.

Clear this checkbox to prevent the Backup Client restoring file and
folder permissions. You would typically only select this option after a
complete server failure (to restore files before user accounts are re
created).

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Restore options continued...

Restore directly to target Select this check box to write files directly to the specified folder

location without using a temporary working folder. The restore process is faster
using this option due to less disk access. Howevera file-level restore
resume is not possible. Should there be a communicationerror during
a file transfer, the complete file will be resent.

5) Note: You can view restore logs on the Logs tab. Restore log dates are displayed in
green.

[ & Backup Selection @l Restore —E—I-l:ugs-i—

27 Jan 2010. 1 rlll| Message: 15:00:57 Wed, 27 January 2010 3:00:57 PM - V6.0.0-70

37 Jan 2010, 15:00:40 [Message: 15:00:57 O5: Mac 05X, 10.6, 1386

37 Jan 2010, 14:51:58 Message: 15:00:57 Using backup account: prepaccount_MAC use
£ - = a

27 Jan 2010, 14:51:10 Me-ss-age: 15:1]4}:5' Connecting to Sti.:rrage Platform on 192.168.21
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Finding files in backups

To find a specific backed up file, it may be easier to use theFind function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and search through previous backups.

To search for afilein  your latest backup:
1. On the File menu, click Find Files in Backups . Alternatively, click the Find button
on the toolbar:

els Qe @©oe

Backup Restore Find Options | Automate

2. Type the file name or part thereof in the File name box, and then click Find .

File name (full or partial): ||
8 Search last backup (local)

C Search through previous backups (Storage Platform)
Search backup dates

[] Limit number of resuits to: 10

Example : If 5 t ait sedrched for, the Backup Client will display a list of all files in the
| ast backup containing fAstatso in the fil

=

& | Tip: Use the* and ? wildcards for advanced search queries.
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To search for a file in previous backups:

1.

,l
)

.
1/
V/

On the File menu, click Find Files in Backups . Alternatively, click the Find button
on the toolbar:

(1) @@ EIC2)

Backup Restore Find (| Options | Automats Help

Type the file name or part thereof in the File name box.

Select theSearch through previous backup s (Storage Platform)  check box.

If you wish to limit the search to particular dates, select the Search backup dates
check boxand then use the Start date and End date boxes to specify a time period.
To limit the number of results that display, select the Limit number of results to
check box and thentype a number in the box provided.

Click Find .

File name (full or partial): | sales
Q Search last backup {local)

e Search through previous backups (Storage Platform)

@ Search backup dates

Start date: | 01-27-2010 | » | MM-dd-YYYY

End date: | 01-27-2010 | » | MM-dd-YYYY

E Limit number of results to: 10

| Find

Tip: Use the* and ? wildcards for advanced search queries.

Note: If Search backup dates is selected the backup date is used for the search
instead of the file create or file modified date.
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To restore files from the Find Files in Backup dialog box:

1. Inthe search results list, include the files to restore by clicking the icons next to the file

names or by Control -clicking each file name and then clicking Include
2. Click the Restore button.

ATTIX®

File name (full or partial): a

The Restore Options

t he
this chapter.

C;' Search last backup (local)

e Search through previous backups (Storage Platform)

@ Search backup dates

Start date: | 01-23-2010 | v | MM-dd-YYYY

End date:

[ Limit number of results to:

01-23-2010 U MM-dd-YYYY

[ Find )
N S
Search result
Folder Filename Size Date File t... Backup Date
01 fUsersfattix5f.ssh config 1 KB 15/09/2009 11:... 23/01/2010 D6:...
& Workspace: backupset.xml 1 KB 23/01/2010 05:... xmil 230172010 06:...
& Workspace: backupset.xml 1 KB 23/01/2010 06:... xmil 23/01/2010 06:...
[ & |workspace: backupset.xmi 1 KB 23/01/2010 06:... xml 23/01/2010 06:...
) Waorkspace: backupset.xmil 1 KB 23/01/2010 06:... xmil 23/01/2010 06:...
) Workspace: backupset.xmil 1 KB 23/01/2010 06:... =mil 23/01/2010 06:...
) Workspace: backupset.xml 1 KB 23/01/2010 06:... xml 23/01/2010 06:...
) Waorkspace: backupset.xml 1 KB 23/01/2010 06:... xmil 23/01/2010 06:...
| Restore |
N S
( Close ) [ Help )
S - S -

restored

f

es .

For

more informat

on

on

dialog box will appear, enabling you to specify the location in which to save

restore

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.

C



ATTIX®

Restoring a backup s election

By default, with every backup performed, a copy of the backup selectionis saved on the Storage
Platform. For more information on backup selection, see fiSelecting data to back up earlier in

this chapter.

This enables you to restore, not onlyyour backed up files and folders, but the selection you used
to back them up as well.

ly ) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire backup setup to perform exactly as it did at the last backup.

To restore a backup selection:

1. Click the Restore tab.
2. Expand the relevant backup folder, and then click the Workspace node.

3. In the right -hand pane, click the icon next to the name of the backupset to include it for
restore. If you have not enabled Multiple Backup Sets (seeMultiple Backup Sets in
Chapter 8, fiOptions and Sethatdisplaygs0), include the

4. Click the Restore button on the toolbar.
5. Select the appropriate restore options. ( See fASelecting data to resto

chapter.)
6. Click OK.

The backup selection will be restored to the location specified in the restore options.
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